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COURSE OBJECTIVES 

By the end of this course you will be able to 

 Briefly describe the difference between an Excel Table and an Excel Range. 

 Correctly create a row formula in an Excel table as specified, without reference to notes. 

 Correctly create a specified PivotTable and PivotCharts, referring to notes if necessary. 

 Correctly create Slicers and Timelines as specified, referring to notes if necessary. 

 Correctly create relationships between tables as specified, without reference to notes. 

 Accurately create a PivotTable that is connected to multiple tables, referring to notes if 

necessary. 

 Correctly add data to the Data Model, without reference to notes. 

 Briefly describe how to achieve date grouping in PowerPivot. 

 Briefly describe how to use the Related DAX function in PowerPivot. 

 Correctly create PowerPivot hierarchies, referring to notes if necessary. 

 Accurately create a PivotTable that uses Key Performance Indicators, referring to notes if 

necessary. 
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MODULE 1 – TABLES, PIVOTTABLES AND PIVOTCHARTS  

OBJECTIVES 

At the end of this section you will be able to: 

 Briefly describe the difference between an Excel Table and an Excel Range. 

 Correctly create a row formula in an Excel table as specified, without reference to notes. 

 Correctly create a specified PivotTable and PivotCharts, referring to notes if necessary. 

 Correctly create Slicers and Timelines as specified, referring to notes if necessary. 

INTRODUCTION 

This course looks at working with Excel Tables, PivotTables, PivotCharts and PowerPivot. It will see 

how these individual elements work and also how they can be all linked to created Dashboards. 

Dashboard reports allow managers to get high-level overview of the business. Excel dashboards are 

powerful, fairly easy to design and a great way to improve your Excel and data visualization skills.  

EXCEL TABLES 

A table is a feature in Excel that makes it easier to format and analyse a set of data points in a 

spreadsheet. 

To convert a given range to a table 

1. Select the range. 

2. On the Insert tab of the Ribbon, in the Tables group, click the Table or, press C + T. 

After the table is created, the Table Tools become available, and a Design tab is displayed. You can use 

the tools on the Design tab to customize or edit the table. Note that the Design tab is only visible when a 

cell in the table is selected. 

To convert a given table to a range 

1. Click in a cell of the table.  

2. On the Table Tools Design tab of the Ribbon, in the Tools group, tick the Convert to 

Range button, then click on Yes. 

To summarize a table 

1. On the Table Tools Design tab of the Ribbon, in the Table Style Options group, tick the 

Total Row box. You will have a new row inserted just below the data set with the totals. 

Equally, you can select any cell in this row and choose from a number of aggregation 

options such as count, min, max etc. 

To rename a table 

You might want to rename the table (from the default of table_1 etc) to something more meaningful.  

1. On the Table Tools Design tab of the Ribbon, in the Properties group, click in the table 

name box and create a new name. Do not use spaces. 

2. Press R after typing the name. 
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To create row formulas 

When entering a formula in a specific row that refers to a cell in another column use point and click to 

select the cell. You will notice that the reference is not a typical cell reference but instead the @ symbol 

followed by the column name. Therefore if you look at the formula  

     =[@Target]-[@Revenue]  

it would subtract the current row value of the Revenue column from the current row value of the Target 

column. Once you complete the formula it is automatically copied for every row of the table. 

PIVOTTABLES 

Simply put, a PivotTable is nothing more than interactive table that contains summarised data. This is 

built around a core of data whose row and column headings can be moved around (pivoted) to provide 

different views of the data. This pivoting of row and column headings is where the PivotTable derives 

its name. PivotTables are particularly well suited for use in analysing large, lengthy lists. You can 

specify how you want the data in the PivotTable to be summarised. Analysing large lists with traditional 

methods could prove unwieldy. Instead, by using a PivotTable, the pertinent information is much easier 

to extract. 

The source data can be in an Excel worksheet or even in another program. Although the data in the 

resulting PivotTable looks like any other worksheet data, you cannot directly enter or change it. The 

PivotTable itself is linked to the source data and the values in the cells are read-only amounts. You can, 

however, change the formatting, and use the PivotTables for charting, etc. 

Creating a PivotTable 

A PivotTable is created with the help of the PivotTable Wizard. 

1. Position in the range of data that you want your PivotTable to be based upon. 

2. Select the Insert ribbon and in the Tables group click on the PivotTable button. 

3. This brings up the Create PivotTable dialog box. This dialog prompts you to select the 

range of data that you want to include in the PivotTable. The range you positioned in 

should be highlighted. If not select the range of data within the spreadsheet. 

4. In the lower half of the dialog choose to insert the PivotTable in a new worksheet, or the 

existing one (in which case you need to indicate the starting cell). 

5. Click on OK. 

6. Excel adds an empty PivotTable report – shown here - to the specified location. 
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7. Excel also displays the PivotTable Fields pane - shown here 

on the right - so that you can add fields, create a layout, and 

customize the PivotTable report. 

 

The layout of the PivotTable Fields pane can be changed by 

clicking on the settings drop-down button above-right of the 

field selection area. Choose whether or not you want the 

fields section only, the area section only or both. 

8. To display a field in the PivotTable click on the field name in 

the fields section. A tick mark will appear in the box by the 

field name and it will normally appear under Rows in the 

Area section below. If the field holds a number value it will 

normally appear under Values in the Area section below – the 

area the fields appear in can easily be changed so do not 

worry if you initially appear to get the wrong summary or 

area set.  

9. As fields are added to the Area section (also known as the 

drop-zone!) so the PivotTable gets drawn/re-drawn. You can 

move fields to different areas by dragging and dropping in to 

a different area section. 

10. The order that fields appear in a PivotTable can be modified easily by dragging the fields 

within an area section in to a different order. Sometimes this can make a PivotTable 

easier to understand. 

The Filters area provides a way to just view a subset of data. For example, if you had a field called 

Region that recorded values of North, South, East or West, then you could drag the Region field to the 

report filter area and then just show results for one or more of the region values. 

 

Changing Summary Options and Number Formatting 

By default the PivotTable will show the Sum of any numeric values without any formatting. 

To change the values summary/number format 

1. In the Values area of the PivotTable Field List click on the drop-down selector of the 

field whose values you want to change 

the summary of. 

2. Select the Value Field Settings menu 

option. 

3. Under the Summarize Values By tab, 

select the appropriate summary option. 

The Show Values As tab governs how the 

summarising is displayed, such as 

percentage of column total, grand total, 

etc. (See the table below.) 

4. Set any formatting of any numbers by 

clicking on the Number Format button. 

5. Finally, click on OK. 

Time for Exercise 1 
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Function Result 

Normal Turns off custom calculation. 

Difference From Displays data as the difference from the value of the Base item in the Base 

field. % Of Displays data as a percentage of the value of the Base item in the Base field. 

% Difference From Displays data as the percentage difference from the value of the Base item in 

the Base field. 
Running Total in Displays the data for successive items in the Base field as a running total. 

% Of Row Displays the data in each row or category as a percentage of the total for the 

row or category. 

% Of Column Displays all the data in each column or series as a percentage of the total for 

the column or series. 

% Of Total Displays data as a percentage of the grand total of all the data or data points in 

the report. Gives a good summary of individual performances. 

Index Calculates data as follows:  

((value in cell) x (Grand Total of Grand Totals)) /  

((Grand Row Total) x (Grand Column Total)) 

Grouping Items 

If you group items you will have even more flexibility when analysing data. Grouping works well on 

any numerical data (including dates). 

Note: Grouping is not available when using PowerPivot which is covered later in the course. 

Grouping Items with Numeric Labels into Ranges 

1. In the PivotTable (not the Field List areas) click on any of the row or column values that 

you would like to group by. 

2. In the extra PivotTable tools ribbons, select the Analyze tab and in the Group group 

click on the Group Field button. 

3. A dialog box displays Excel's guesses as to how you want to group the data. Either 

accept or enter new values in the Starting At, Ending At and By boxes.  

4. Click on OK. 

Copying a PivotTable 

It is simple to copy a PivotTable. You might want to do this to set up different summary views without 

anyone else having to change fields around in the Area section, or drop-zones. 

To copy a PivotTable 

1. Click in a PivotTable then press C + A on your keyboard. 

2. Now use the clipboard to copy the table, or press C + C on your keyboard. 

3. Position in your worksheets where you want the new table to start. 

4. Paste the copy. Each PivotTable is independent of the other so field changes in the areas 

section, or drop-zones, will only affect the PivotTable you are positioned in. 

Note: PivotTables cannot overlap each other and you will be warned if by moving fields 

around the resultant table will encroach upon another table in the same worksheet. 
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CALCULATED FIELDS IN PIVOTTABLES 

In a PivotTable, you can create calculated fields, using formulas that work with the sum of other pivot 

fields. There are some limitations to what a calculated field can do, but they let you add more power to 

your PivotTables. 

Here are some of the features and limitations of calculated fields: 

Features 

 For calculated fields, the individual amounts in the other fields are summed, and then the 

calculation is performed on the total amount. 

 Calculated fields are automatically available in all PivotTables that are based on the same 

pivot cache 

Limitations 

 Calculated field formulas cannot refer to the PivotTable totals or subtotals 

 Calculated field formulas cannot refer to worksheet cells by address or by name. 

 Sum is the only function available for a calculated field. 

 Calculated fields are not available in an OLAP-based PivotTable. 

 Calculated fields can be incorrect when grouping is applied. 

To insert a calculated field 

1. In the extra PivotTable tools ribbons, select the Analyze tab and in the Calculations 

group click on the Fields, Items, & Sets button. 

2. Select the Calculated Field option. 

3. Excel opens the Insert Calculated Field dialog box.  

4. Type a name for the calculated field in the Name box.  

5. In the Formula box, type the formula you want for the calculation. If you want to refer to 

a field name select it in the Fields list in the dialog and click on the Insert Field button.  

6. Click Add to save the calculated field, and then click on Close. 
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EXERCISE 1  

1. Open the file called Stationery 

2. On this sheet convert the list of data into an Excel table. 

3. Rename the table as StationeryOrders (note no space!) 

4. Create a new calculation in the first blank column based on Cost multiplied by Units. 

5. Name this new column OrderValue. 

6. Now using this table create a Pivot Table on a new worksheet. 

7. On this Pivot Table display data to show the sum of the OrderValue broken down by Product 

and Region. Put Product in Rows and Region in Columns.  What is the overall value of all 

orders placed for this period?   

 

The answer should be 19333.79. 

8. Modify the Pivot Table to show Order Status in the Columns area as the only field. How much 

of our grand total is cancelled orders?  

 

The answer should be 1470.79. 

9. Which rep is achieving the highest value of orders?  What would you have in the Rows drop-

zone to show this information? 

 

The answer is Andrews with 5474.19 although part of this is 111.44 of cancelled orders. We 

only need the Rep field. 

10. Close and save the changes. We will use this file again in the next exercise. 
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EXERCISE 2  

1. Open the file called Stationery and view the Pivot Table. 

2. Your Pivot Table should look like this from the last exercise, if not make changes so it does. 

 

3. Change the Value field settings to show a summary as a percentage of the Grand Total.  Which 

salesperson has the highest percentage of cancelled orders? 

 

The answer is Sorvino with 2.71%. 

4. Restore the Value Field Settings back to No Calculation, and apply a number format of 

Accounting showing 2 decimal places. 

5. Place the Date field on the columns drop-zone (make it the only one there). 

6. Now create a calculated field (Pivot Table Tools, Analyze tab, Calculations group, Fields, 

Items & Sets button). Give the new field the name of Sales. Use the formula =Cost * Units. 

7. Drag your new Sales field from the field list onto the Value drop-zone and see how it is the 

same number as our OrderValue field. 

 

So to summarise, back in the previous exercise you created a calculated field in the table called 

OrderValue which was Cost * Units. You have now created a calculated field in the Pivot 

Table called Sales which is Cost * Units. They both show the same sum values. 

 

Now we will see one disadvantage of Pivot Table calculated fields. 

8. Click on one of the dates in the Pivot Table, and then apply grouping by month only. 

 

Examine the values for Sum of OrderValue and Sum of Sales. Sum of OrderValue is correct! 

9. Delete the Sales calculated field so it does not appear in the Field List, then close the file and 

save the changes. 
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